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1. Abstract

This document provides instructions on how to get started with the PicoP Software Development Kit
(SDK) for Windows. The PicoP SDK for Windows allows devel opers to quickly and easily integrate
PicoP Projector control into a Windows application. The Windows Application can communicate
with PicoP Display Engine over USB or UART. The SDK package includes the C Application
Programming Interface (API), SDK libraries, documentation, and sample projects that demonstrate
use of some basic PicoP Display Engine (PDE) functions. The sample console applications have
been developed and built using Microsoft Visual Studio 2010(Ultimate). The sample Qt demo
applications are built with QtCreator 2.0.0.
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3. Installing PicoP SDK

The PicoP Windows SDK is ddivered as a compressed zip file named
PicoP_Windows SDK Ver X Y Z.zip. The X_Y_Z postfix of the file name represents the version
number of the SDK (X equals the magjor version, Y the minor version, and Z the patch number of the
SDK). Toinstall the SDK, simply unzip the file into c:\PicoP_Windows SDK or another directory
of your choice. The unzipped destination folder will contain the following:

[E=PicoP_Windows SDK
[=Docs
(=rReference_Guide
[# indexJrml
[ X himd
# EULA pdf
#| Programmers_Guide pdf
[rinterface
# PicoP_ALC_ Apih
m_| PicoP Defh
[# PicoP RCh
[=Lib
% PicoP_ALC_Apidll
# PicoP _ALC_Apilib
# PicoP_ALC_Api SLiblib
[E=Lib_64
% PicoP_ALC_Apidll
""_| PicoP ALC Apilib
# PicoP_ALC Api SLiblib
B‘Sa.mples
(=Bin
Climageformats
libgee s dw2-1.411
mingwml0d1l
PicoP ALC Apidll
PicoP ALC Console.exe
PicoP ALC QiConirolPanel.exe
PicoP ALC QiDisplayCorrection.exe
i PicoP ALC OtWarp.exe
) & QiCored A1l
) QtGuid.dll
EBm_m
I:I imageformais
# PicoP_ALC Apidll
#| PicoP_ALC_Console.exe
#| PicoP _ALC_QiControlPanel.exe
# PicoP ALC_(QiDisplayCorrection.exe
| PicoP_ALC_QtWarp exe
# QtCored Al
| QiGui4.dll
COPicoP ALC Consele
COPicoP ALC QiControlPanel
COPicoP ALC QiDisplayCorrection
 COPicoP_ALC_QtWarp
[# Getting_Started Guide pdf

BB B |

e (B | EH B
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Thefiles/foldersincluded in the SDK distribution package are described in more detail below:

PicoP_Windows_SDK SDK Root folder
Docs
Reference_Guide Detailed Programmer’s Reference Guide
index.html Programmer’s Reference Guide entry point
* html Programmer’s Reference Guide documentation
Programmers_Guide.pdf High-Level Programmer’s Guide
EULA.pdf SDK End User License Agreement
Interface
PicoP_ALC_Api.h PicoP SDK header file
PicoP_Def.h PicoP SDK definitions files
PicoP_RC.h PicoP SDK return codes
Lib PicoP SDK 32 bit Windows libraries
PicoP_ALC_Api.dll PicoP SDK dynamic library
PicoP_ALC_Api.lib PicoP SDK import library
PicoP_ALC_Api_SLib.lib PicoP SDK static library
Lib_64 PicoP SDK 64 bit Windows libraries
PicoP_ALC_Api.dll PicoP SDK dynamic library
PicoP_ALC_Api.lib PicoP SDK import library
PicoP_ALC_Api_SLib.lib PicoP SDK static library
Samples
Contains the 32 bit executables for the sample
Bin applications.
Contains the 64 bit executables for the sample
Bin_64 applications.
Simple Console Application demonstrating the
PicoP_ALC_Console basic usage of the SDK native C APIs
More Advanced Qt Demo project demonstrating
PicoP_ALC_QtControlPanel use of additional API functions
More Advanced Qt Demo project demonstrating
PicoP_ALC_QtDisplayCorrection | use of additional API functions
More Advanced Qt Demo project demonstrating
PicoP_ALC_QtWarp use of additional API functions
This Getting Started guide for PicoP Windows
Getting_Started_Guide.pdf SDK.

4. SDK Documentation

For high level description of functions/‘commands supported by the PDE Application Programming
Interface (API), please refer to the Docs\Programmers Guide.pdf.

For detailed description of the C-language API, please refer to the Programmer’s Reference Guide at
Docs\Reference_Guidelindex.html. The Reference Guide is a set of hyperlinked HTML files
containing detailed description of all Function interfaces and definitions provided by the API.
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-
|ﬂ PCK ALC: E:/PDE/Sof 2Ceding| K/interfa
m‘!‘E & | E\Product:\FicoP_Windows_SDK\Docs\Reference Gude\_pico_p_ a

__ap_8n.ktrel -

Fie Edit View Favortec Took Helo

|
5= havontes | 55 @ Suggested Stes v | Get Mere Add-ons ~

I @vnmmF-Jpm(_n:nﬂmm;cnmng;aimp_\n\.'fmm...| | Mo~ v [* %% v Pagev Safetyv Toosv @hv

#delineg MV_ALC_API
Functions

MV_Al C_APT BTCOP_RC PicoP_AI C_Openlihrary (PicoP_HANDI F *hihraryhandie)
This function must be the first call irto the ALC library. It opens the library and allocates resources necessary for
operanon. It returns a hardle to the lbrary that must be used in subseguent cals.

MV_AI C_APT FTCOP_RC PicoP_AI C_Clnsel ihrary (PicnP_HANDI F ihraryHAande)

This function closes the ALC API library and releases all resources. It also closes all the oper connections.

MV_ALC_API FICOP_RC PicoP_ALC_GetLibraryInfo (FicoP_HANDLE libraryHandle, PicoP_LibraryInfo =liararvInfo)

This function returns the version and capaoilty informaton of the ALC APT library.

MV_al C_APT BICOP_RC PicoP_AI C_OpenConnection (PicoP_HANDI F lihrarvHandle, PicoP_ConnectionTypeF connertinnType,

PicoP_ConnectionInfo connectionInfo, PicoP_ HANDLE *connzciionHandle)

This function opens a connection to the Projector Display Engire using either LSB or RS232.
MV_al C_APT BICOP_RC  PicoP_AI C_CloseConnaction [PicoP_HANDI F cornectinnHardlz)

This function Closes a previously opened cornection to the Frojector Display Cngine.

MV_ALC_API FICOP_RC PicoP_ALC_SetBrightnessVal (FicoF_HANDLE connectionHandle, FP32 brghtnessValue, BOOL commit)
This funchion sets hnghtness for the antpit display.

MV_ALC_API PICOP_RC PicoP_ALC_ GetBErightnessVal (PicoP_ HANDLE connecticnHandle, FP22 *brightnessValue, PicoP_ValueStorageTypeE
storageType)

This funchian gets hnghtness for the cotpet display.

MV_al C_APT BTICOP_RC  PicoP_AI C_SetAspectRatioMode (PicoP_HANDI F connertinonHandle, PicnP_AspectRatinModeF aspertRatio, RODI
commit)

This function sets aspect ratio for the output disclay.

MV_Al C_APT BETCOP_RC PicoP_AI (_GethspectRatinMode (PicoP_HANDI F connectnnHandle, [ITNT22 *aspedRatin, PicoP_ValueStorageTypeF
storageType)

This function gets asped ratio “or the output dsplay.
MV_al C_APT BTCOP_RC Ii'_iml_l_nl_f?_ﬁet(‘nlr_hrllndp_ (Rirrp_HnNm F_‘_':nr_lnpr:t'innHaanIp, PicoP_ColoarModeF colorMeode, ROOI commit)

& Curnpuler | Protecled Mude: Off i ~ ®100%
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5. The PicoP Application Programming Interface (API)

The PicoP SDK for Windows allows you to easily interface your application software with the PicoP
Display Engine. This section explains the steps of the integration process.

The same PicoP SDKs can be used with both first and second generation PicoP Display Engines
(PDEs), dso known as PDE1 and PDE2. However, not all API functions are supported on each
platform generation. The API description tables also indicate whether the function is supported by
first generation PDE1 and/or second generation PDE2.

5.1. SDK Version Control

The SDK API version is specified in the APl Header file

/// The major version number of this API header file
#define ALC_API_VERSION_MAJOR ©
/// The minor version number of this API header file
#define ALC_API_VERSION_MINOR 12

In addition to the API version, the library also contains a version that can be queried with the
Pi coP_ALC Get Li braryl nfo() function. The Mgor and Minor version of the library should
match the Mgor and Minor version of the API. The library version information also includes a
Patch number and capability flags which can differentiate library implementation enhancements that
are compatible with the same API and header files.

/** Library information */
typedef struct{

UINT8 majorVersion; /**< Contains the major version of the library */
UINT8 minorVersion; /**< Contains the minor version of the library */
UINT8 patchVersion; /**< Contains the patch version of the library */

UINT32 capabilityFlags; /**< Flags that describe the capability of the library */
} PicoP_LibraryInfo;

5.2. Step 1: Initialize the SDK Library
The first step in connecting to a PicoP is to initialize the PicoP library by calling

Pi coP_ALC QpenLibrary(). The PicoP_ALC OpenLi brary() function returns a handle to
thelibrary that can be used to open a connections to the PicoP device.

5.3. Step 2: Connect to PicoP

After successful initialization of the library, the next step is to create a connection to the PicoP
device. The connection can be established using either USB or UART physical interfaces (For more
information on the USB and UART Physicd Interfaces, please refer to the PDE Interface Control
Document (ICD)). To connect, call the PicoP_ALC OpenConnection() function. Upon
successful connection, the library will return a connection handle to be used with subsequent library
calls. The connection handle identifies the connected PicoP.
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5.4. Step 3: Configure and Control PicoP

The PicoP AP is split into the following functional categories:
Connection Management: Connect to PicoP over USB or UART.
Display Control: Configure the PicoP Display.

Input Control: Configure the PicoP Input Video.

Rendering: Render images and test patterns into Framebuffer and On-Screen Display
(OSD).

System Management: Manage the PicoP System, Firmware upgrades, Event Log, €etc.

5.4.1. Connection Management

The Connection Management Functions are used to connect to the PicoP Display Engine using USB
or UART:

Description PicoP  PicoP
Genl Gen2
PicoP_ALC_OpenlLibrary( ) Opens the library and allocates v v

resources necessary for operation. It
returns a handle to the library that
must be used in subsequent calls
PicoP_ALC _CloseLibrary() Closes the library and releases all v v
resources. It also closes all the open
connections.

PicoP_ALC _OpenConnection() Opens a connection to the PicoP v v
Display Engine using either USB or
UART.

PicoP_ALC _CloseConnection( ) Closes a previously opened v v
connection to the PicoP Display
Engine.
PicoP_ALC_EnumerateDevices() Enumerates PicoP devices connected v v
through USB.

PicoP_ALC_OpenConnectionUSB() Opens a connection to the PicoP v v
Display Engine using USB.

PicoP_ALC_OpenConnectionRS232() | Opens a connection to the PicoP v v
Display Engine using UART.

5.4.2. Display Control Functions

Doc #: DA0127245, Rev. C.1 Date: 18-June-2012 Page 6 of 22
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The Display Control Functions can be used to configure the output display.

PicoP | PicoP

Description

PicoP_ALC _SetBrightnessVal( )

Sets brightness for the
output display.

PicoP_ALC _GetBrightnessVal( )

Returns brightness
setting of the output
display.

PicoP_ALC _SetAspectRatioMode( )

Sets aspect ratio for
the output display.

PicoP_ALC _GetAspectRatioMode( )

Returns aspect ratio
setting of the output
display.

PicoP_ALC _SetColorMode( )

Sets color mode for
the output display.

PicoP_ALC _GetColorMode( )

Returns color mode
setting of the output
display.

PicoP_ALC _SetGammaVal()

Sets gamma value for
the output display.

PicoP_ALC _GetGammaVal()

Returns gamma value
setting of the output
display.

PicoP_ALC _Fliplmage()

Flips the image
horizontally or
vertically.

PicoP_ALC_SetFlipState()

Sets the flip state of
the image to
horizontal, vertical,
both horizontal and
vertical or none.

PicoP_ALC_GetFlipState()

Returns the current
flip state of the output
display.

PicoP_ALC_SetupWarp()

Sets up the input and
destination size for
Warp

PicoP_ALC_GetWarpSetup( )

Gets warp set up. x

PicoP_ALC Warplmage( )

Applies a warp
operation to the
image.

PicoP_ALC_GetWarpParameter( )

Gets the warp x
settings.
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PicoP_ALC_SetWarpState()

Enables or Disables
the warp operation

4

v

PicoP_ALC_GetWarpState()

Returns the current
warp state of output
display.

PicoP_ALC _SetOutputVideoState( )

Enables or Disables
the output video.
When output video is
disabled, the display is
blanked.

PicoP_ALC _GetOutputVideoState( )

Returns the current
state of Output Video.

PicoP_ALC _CorrectKeystone( )

Apply symmetrical
keystone correction
operation to the
output display.

PicoP_ALC_GetKeystoneCorrection ()

Gets keystone
correction settings.

PicoP_ALC SetPhase()

Sets the scan line
phase delay to align
the forward and
reverse scan video.

PicoP_ALC GetPhase()

Returns the scan line
phase delay setting.

PicoP_ALC_AutoSetGreenMagentaBalance()

Performs the auto
adjust of the green-
magenta balance

PicoP_ALC_GetAutoGreenMagentaBalanceStatus()

Gets the status of the
auto green magenta
balance command.

PicoP_ALC_SetGreenMagentaBalance()

Performs the manual
adjust of the green-
magenta balance

PicoP_ALC_GetGreenMagentaBalance()

Gets the green
magenta balance
offset value.

PicoP_ALC_SetColorAlignment()

Performs vertical or
horizontal color
alignment for the
selected color

PicoP_ALC_GetColorAlignment()

Gets the color
alignment offset of
the chosen color

PicoP_ALC_SetColorConverter()

Sets the color
converter values

Doc #: DA0127245, Rev. C.1 Date: 18-June-2012
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PicoP_ALC_GetColorConverter() Gets the color v v

converter values
PicoP_ALC_SetScanAngle() Set the scan v v

angle(NOTE: Only

applicable to certain

platforms)
PicoP_ALC_GetScanAngle() Gets the scan v v

angle(NOTE: Only

applicable to certain

platforms)

x v

PicoP_ALC_GetViewportDistortion( )

Gets viewport
distortion parameters.

PicoP_ALC_SetOutputVideoStateEx( )

Sets the output video
state to be committed
to enabled or
disabled.

PicoP_ALC_GetOutputVideoStateEx( )

Gets committed
Output Video State.

PicoP_ALC_SetSplashScreenTimeout( )

Sets the timeout for
displaying splash
screen.

PicoP_ALC_GetSplashScreenTimeout( )

Sets the timeout for
displaying splash
screen.

PicoP_ALC_SetVerticalProjectionAngleOffset( )

Sets the vertical
projection angle
offset.

PicoP_ALC_GetVerticalProjectionAngleOffset( )

Gets the vertical
projection angle

offset.

5.4.3. Input Control Functions

The Input Control functions are used to configure the PicoP Input Video.

Function

PicoP_ALC_SetlnputCaptureModelnfo( )

Description

Configures custom
input video modes to
be accepted by PicoP.
These new modes
augment the video
modes already

PicoP
Genl

PicoP
Gen2
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supported by the
PicoP.
PicoP_ALC_ModifylnputCaptureModelnfo() Modifies the video v v
capture mode.
PicoP_ALC _GetlnputCaptureModelnfo( ) Gets information v v

about the supported
input video modes
PicoP_ALC_SetActiveCaptureMode( ) Sets the input video v v
capture mode to use.
Incoming video MUST
match the parameters
defined by the given
mode to be displayed
correctly.
PicoP_ALC_GetActiveCaptureMode( ) Returns the currently v v
used input video
capture mode.

PicoP_ALC_CommitlnputCaptureMode() Commits the input v v
video capture mode.
PicoP_ALC_GetCommitedInputCaptureMode() Returns the v v

committed video
capture mode.
PicoP_ALC_GetInputVideoProperties( ) Returns detected v v
input video Frame
Rate and Lines per
Frame.
PicoP_ALC_SetlnputVideoState( ) Enables or Disables v v
the input video. When
input video is disabled,
the framebuffer will
not be updated and
the output video will
contain the last
captured frame.
PicoP_ALC_GetlnputVideoState( ) Returns the current v v
state of the input
video.

5.4.4. Rendering Functions

The Rendering function alows the host system to render information into the PicoP On-Screen
Display (OSD) or FrameBuffer.

Function Description PicoP  PicoP

Genl Gen2
PicoP_ALC _SetOSDState( ) Enables or Disables the On-Screen v v

Doc #: DA0127245, Rev. C.1 Date: 18-June-2012 Page 10 of 22
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Display (OSD)
PicoP_ALC _GetOSDState( ) Returns the On-Screen Display (OSD) v v
state.
PicoP_ALC _SetOSDInfo( ) Set the Size and Position of the On- v v
Screen Display (OSD) within the output
video area.
PicoP_ALC _GetOSDInfo( ) Returns the current Size and Position of v v
the On-Screen Display.
PicoP_ALC _GetDisplayInfo() Returns the current size of the v v
FrameBuffer used for rendering.
PicoP_ALC Set the frame buffer to be used for video v v
_SetActiveFrameBuffer( ) output.
PicoP_ALC Returns the currently active frame buffer v v
_GetActiveFrameBuffer( ) used for video output.
PicoP_ALC_SetActiveOSD() Sets the active OSD to be used for video v v
output
PicoP_ALC_GetActiveOSD() Gets the active OSD used for video v v
output
PicoP_ALC LoadBitmaplmage() | Loads a bitmap image into the OSD or v v
FrameBuffer.

PicoP_ALC DrawTestPattern() Displays one of the built-in test patterns. v v
PicoP_ALC DrawText() Queues a command to displays Text in v v
the OSD or FrameBuffer
PicoP_ALC _GetTextBoxInfo( ) Returns the dimensions of the bounds of v v

the rectangular region that will be filled
with the given text (but not actually
drawn). Provides the APl user with
feedback to determine where to draw
text.
PicoP_ALC DrawPoint() Queues a draw command to set a single v v
pixel in the OSD or FrameBuffer.
PicoP_ALC DrawlLine() Queues a draw command to draw a line v v
segment between two points.
PicoP_ALC DrawTriangle() Queues a draw command to draw and fill v v
a triangle bounded by 3 points.
PicoP_ALC DrawRectangle() Queues a draw command to draw and fill v v
a rectangle into the OSD or FrameBuffer.
PicoP_ALC Render() Renders queued draw commands into a v v
Render Target. Note that rendering into
a framebuffer that is actively capturing
input video will result in the rendered
pixels to be overwritten by input video.
PicoP_ALC_ClearTarget() Clears the selected render target. v v
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5.4.5. System Management Functions

The System Management Functions are used to control the PicoP System and to access the system
information.

Function Description PicoP  PicoP

Genl Gen2
PicoP_ALC_GetSystemStatus( ) Retrieves the system status. v v
PicoP_ALC_GetSystemInfo( ) Retrieves system information. v v
PicoP_ALC_GetEventLog( ) Retrieves the system event log. v v
v v

PicoP_ALC_RestoreFactoryConfig() | Restores System Settings to Factory
Configuration.

PicoP_ALC_SetSystemPowerState( ) | Sets the System Power State v v
(Standby, Off).

PicoP_ALC_GetSystemPowerState( | Returns the current system Power v v

) State.

PicoP_ALC_SaveSplashScreen( ) Takes a snapshot of the specified v v
frame buffer and saves the content
as the Splash Screen.

PicoP_ALC_UpgradeSoftware( ) Upgrades the embedded Software. v v

PicoP_ALC_UpgradeSoftware_Ex() | Upgrades the embedded Software v v
and gives progress status in a callback
function.

PicoP_ALC_UpgradeFpga( ) Loads upgrade of the embedded x x

FPGA Firmware (NOTE: Only
applicable to certain platforms)
PicoP_ALC_GetBatteryStatus( ) Return the charge state of the x x
battery (NOTE: Only applicable to
certain platforms)

5.5. Step 4: Exit Application

To gracefully exit the host application, call the PicoP_ALC O oseConnection() and
Pi coP_ALC d oselLi brary() functionsto shut down the connection to PicoP and to release all
resources used by the library.
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6. “Hello, World* - Program
The below listing shows a simple “Hello, World” sample program with a PicoP connected to the USB

port:

i nt

{

mai n(int c, char argv[])

Pi coP_HANDLE | i bHandl €;
Pl COP_RC ret = eSUCCESS

/* Open the ALC library */

ret = PicoP_ALC OpenLibrary(& ibHandl e);

if (eSUCCESS != ret)

{
printf(“Error opening ALC library\n™);
return -1;

}

Pi coP_HANDLE connecti onHandl e;

Pi coP_Connecti onl nfo connecti onl nf o;
connecti onl nf o. connecti onType = eUSB

connect i onl nf o. usbl nf o. product | D = 0x0004;
connecti onInfo.usblnfo.serialNumber = “XxXxXxxx;

ret = PicoP_ALC OpenConnection(libHandl e,
connecti onl nf o,
&connect i onHandl e) ;
if (eSUCCESS != ret)
{
printf(“Error opening USB connection\ n);
return -1;

}

/* Get brightness val */
FP32 bi rght nessVal
ret = PicoP_ALC GetBrightnessVal (connecti onHandl e,
&brightnessval, 0); //get current va

/* Disable Input Video */
ret = PicoP_ALC Setl nputVi deoSt at e(connecti onHandl e,
el NPUT_VI DEO DI SABLED) ;

/* Draw Text */

Pi coP_Poi nt startPoint = {430, 240}; /* ~ Mddle of display */
Pi coP_Col or col or = {255, 255, 255, 0}; /* Wiite */

Pi coP_Col or bgColor = {0, 0, 255, 0}; /* Blue */

ret Pi coP_ALC Dr awText (connecti onHandl e, O,
(char *)”Hello, World from PicoP”,
23, startPoint, color , bgColor);

Pi coP_ALC Render ( connecti onHandl e);

ret

/* Close connection and ALC library */
Pi coP_ALC _C oseConnecti on(connecti onHandl e);
Pi coP_ALC C oseLi brary(li bHandl e);
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6.1. Recommended Program Flow

picoP

MicroVision

AP
PicoP ALC Openlibrary()

Open the ALC library

If returns

aSUCCESS

Yes

¥

AP
PicoP ALC OpenConnection()

Open connection to the PicoP device using either
USB or R5232

If raturms
eSUCCESS

Yes

3

AP
PicoP_ALC_GetXXX
PicoP_ALC_Setoo

Send command to PicoP device

Yes

'

More
commands to
sand

Mo

1

AP
PicoP ALC CleseConnectiond)

Close connection to the device

AP

PicoP ALC Closelibrary(

Close ALC library

/ o )
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7. The Console Demo Project

The Console Demo project is a simple console application developed in C. It demonstrates the use of
SDK interfaces to communicate with the PicoP device and to control basic Projector functions. The
application can control, e.g., the following PicoP operations:

Get Library Info

Change Brightness

Change Color Mode

Read System Info

Display Test Pattern

Flip Image Horizontally

Flip Image Verticaly

e CAWINDOWSsystem32\emd. exe
Console application for PicoP ALC..

Wm&!—m&mﬂaln "Enu_

Get Library Info
Set Brightness
Get Brlghtness
Set ColorMode
Get ColorMode
Read System Information
Flip Image Horizontallwy
Flip Image Vertically

. Draw test pattern

. Get system status

. Clear

- Exit

3o e -Jof-Jof 30 30 - Jof-of - J0f - Jof -Jof~3uf 3 -Jof -Jof-3uf 3 -of-Jof-3of- 30 -J0f - Jof~of~3af-Jof-Jof-Jof~3uF 3 -Jof-Jof-oE -0 -Jof-of-uf-30f-Jof-Jof-uf~3uE—Jef-Jof-of 330 - Jof-ef-uE-Jof-Jof -Jof~3uf 30 -Jof-Jof-uf 3 -ef-Jof-of-Jef-Jof - oo -eE- -

Enter the Menu Id :

Brightness values
1. High 2. Medium 3. Lou

Enter the submenu Id for Brightness Ualue : 1
Brightness szet to HIGH

Console Demo Application — Setsbrightnessvalueto HIGH

7.1. Prerequisites
The System Requirements for running the Console Demo project are:
Pentium class or faster CPU with at least 512 MB of RAM.

Windows 32-bit operating system or Windows 64-bit operating system.: Windows XP, Vista,
or Windows 7

Microsoft Visua Studio 2010(Ultimate) or later.

Note: For compiling 64 bit applications, Microsoft Visua Studio with 64 bit compiler is
required.
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7.2. Running the Console Demo
To build and run the Console Demo, please follow the below steps:

1. Open the Solution/Project file
- Navigate to ‘PicoP_Windows SDK\samples\PicoP_ALC_Console’ and double click on

the ‘PicoP_ALC_Console.dn’ file.
Thissolution is created using V S2010(Ultimate). If you are using a newer version of
Visua studio, conversion wizard will assist you to convert it to the newer version.

2. Check Dependencies

This solution assumes SDK header files are available at relative path

‘PicoP_Windows_SDK\Interface’ and library from ‘PicoP_Windows_SDK\Lib’.

If you are running the Console demo from a different path, update following project settings.
SDK header file path at : Project-> Properties - C/C++ - Additional Include directories
SDK lib path at : Project->Properties = Linker-> Additional Dependencies

If you are using a 64 bit platform, do the following.

Change the solution platform type from Win32 to x64.
Change the library path from ‘PicoP_Windows_SDK\Lib’ to
‘PicoP_Windows_SDK\Lib_64" by updating the following project settings

0 SDK lib path at : Project->Properties > Linker-> Additional Dependencies

3. Build and Run the application
For running the application the PicoP_ALC_Api.dll isto be copied where the executable

‘PicoP_ALC_Console.exe “is present.

Doc #: DA0127245, Rev. C.1 Date: 18-June-2012 Page 16 of 22



IMAGE BY
Getting Started with Microvision PicoP® SDK for Windows Ver. 0.12 D I C D p

MicroVision

8. The Qt Demo Projects

The Qt Demo applications are more advanced Graphical User Interface (GUI) based host application
developed with Qt. These applications connect to the PicoP device through USB port.

8.1. PicoP_ALC_OQtControlPanel
This application demonstrates how to perform the following PicoP Operations from a GUI
- Get Library Info
Read System Info
Change Brightness
Change Aspect Ratio
Change Color Mode
Set Gamma
Flip Image Horizontally
Flip Image Verticaly
Display Test Pattern
Set Display Resolution to match built-in capture modes
Perform Phase adjustment

. PicoP_alC_OtControlPanel

Image Settings | SystemInfo | Test Pattern |

PicoP Image Settings

Aspect Ratio

) wide (%) Mormal i) Zoom
Gamma

) High * Medium ) Low
Color Mode

(=) Brilliant ) Standard ) Inverted

Brightness
) High ) Medium %) Low

Resolution

Resolution ;5433430 9| Set

Device Connected w2

Qt ControlPanel Application: | mage Settings tab
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. PicoP_alLC_OtControlPanel

| Image Settings | SystemInfo | Test Pattern |

System Info
API Version 0.9
Library Version 0.9.0
Serial Number PDE-3105
Software Version 0x332cd110
Flip Image
[ ] Horizontal [] wertical

Image Alignment
-

J

http: S www. microvision.com

Device Connected it

Qt ControlPanel Application: System Statustab

. PicoP_alC_OtControlPanel

Image Settings | System Info | Test Pattern

Start Point Dimension
X | | width | |

¥ | Height | |

Pattern Color

R [q = Ei'u—ﬂﬂ

|

=
]
b2
=

Background Color

o @ <h8l*b® *E=

Render Target  FRAMEBUFFERO v [ Draw |
Pattern Type |EHEEICER BOARD PA V| [ Clear ]
Display Time D Seconds

Device Connecked L

Qt ControlPanel Application: Test pattern tab

Doc #: DA0127245, Rev. C.1 Date: 18-June-2012 Page 18 of 22



IMAGE BY
Getting Started with Microvision PicoP® SDK for Windows Ver. 0.12 D I C D p

MicroVision

8.2. PicoP_ALC_QtDisplayCorrection
This application demonstrates how to perform the PicoP Keystone correction operations from a GUI.

PicoP_AlLC_ QtDisplayCorrection

CorrectKeystone | YiewPortDistortion |

Correct Keystone

=
J
|

Apply ] I Reset ]

StorageType | o |

Qt DisplayCorrection Application: Correct Keystone tab
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PicoP_ALC_ OtDisplayCorrection

Top Left Corner Offset
-100 %o j +100 %o

Top Right Corner Offset
-100 % | j +100 %

Lower Left Corner Offset

-100 %o 1 +100 %
L
Lower Right Corner Offset
-100 % j +100 %
Apply l [ Reset ]

Storage Type |ELIRRENT b

Qt DisplayCorrection Application: ViewPort Distortion tab

8.3. PicoP_ALC_QtWarp
This application demonstrates how to perform the Warpl mage operations from a GUI.
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PicoP_ALC_QtWarp

Warp

WarpOperation

@' Rotate

i) smile

(") Parallelogram

") Stretch Upper Left
(") stretch Upper Right
i) stretch Lower Left
") Stretch Lower Right
) scale Horizontal

i) scale ¥ertical

11
J

-90.0 ~+90.0
[ Apply l [ Reset
WarpSetup
Dimension
Source | 848x480 '

W
— Apply |

Destination 848480

Read Warp Parameters

StorageType |Current V| [ Read

Read Warp Setup

StorageType il:urrent V| [ Read J

Note:

Qt Warp Application

The warp functions only works for external video. It does not work for splash screen or test patterns.

8.4. Prerequisites
The System Requirements for running the Qt Demo project are:
- Pentium class or faster CPU with at least 512 MB of RAM.
Windows 32-bit operating system or Windows 64-bit operating system: Windows XP, Vista,

or Windows 7

Qt 4.7.0 or later. Qt can be installed from http://qgt.nokia.com/downloads

QtCreator 2.0.0

Qt Visual Studio Add-in to build applicationsin 64 bit operating system.

8.5. Building and running Qt Demo Applications
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Tobuild and run Qt Demo applicationsin Windows 32 bit oper ating system
1)Using QtCreator

To build and run Qt Demo applications using the IDE QtCreator v. 2.0.0, please follow the below
steps.

1. Open QtCrestor.

2. Browse and open the .pro file using File->Open option in the QtCreator IDE.

3. Set the build directory path for the project using the option Projects->Build Settings->Build

directory.

4. Create Makefile using Build->Run gmake option in the QtCreator IDE.

5. Build the project using Build->Build Project option in the QtCreator IDE.

6. Run the application using Build->Run option in the QtCreator IDE.

Tobuild and run Qt Demo applicationsin Windows 64 bit operating system
1)Using QtCreator

The Qt demo applications can also be build using QtCreator in windows 64 bit OS by just
following al the above steps (mentioned for 32 bit) and by changing the library path to ../Lib_64/

2) Using Qt Visual Studio Add-in

To build and run Qt Demo applications in Windows 64 bit operating system, use Qt Visual Studio
Add-in.
1. Open Microsoft Visual Studio 2005.
2. Browse and open the .pro file by selecting the menu Qt-> Open Qt Project File(.pro) in the
Visua Studio IDE.
3. Check whether the platform type is x64 in the Solution Platform combo box. If not select the
same.
4. Setthelibrary path to ../Lib_64/ by updating the following project settings.
SDK lib path at : Project->Properties > Linker—>Input-> Additional Dependencies
5. Build and run the application.

Note:
This solution assumes SDK header files are avail able at relative path
‘PicoP_Windows SDK\Interface’ and library from ‘PicoP_Windows SDK\Lib’. If you
are running the Qt demo from a different path, update following project settingsin the

.profile
0 SDK header filepathat : ALC LIB_PATH
o SDK libpath at : INCLUDEPATH

Copy the dll ‘PicoP_Windows_ SDK\Lib\ PicoP_ ALC_Api.dil’ to the path where the
executable is being created.
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